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Welcome back! This is the third of four parts of the Topaz Labs Photography Collection. Next month will be the last part of this review, so stay tuned!

This month we will take a look at these plug-Ins:

Impression, InFocus, Lens Effects, and PhotoFXlab. In next month’s installment, I will highlight the last four plug-Ins, which are ReMask, ReStyle, Simplify, and Star Effects.

Topaz Impression
No matter what a lot of people may say, photography is an art, much the same s painting, sculpture, graphic design, and many other genres are also art. It is a craft that takes time to learn how to create in, and one that evolves as time goes by. Many want to say it is not art, as anyone can take a photograph. In the world of today with the mobile devices that can capture an image, this is true. But to create an image that captures a slice of time and can move one to great joy or despair, laughter or tears, takes an artist to create. And that creation is art.

Prior to the early 1800s, portraits and landscapes and still life scenes were the realm of the painter to capture. The masters took their time to perfect their craft, and presented the world with a great many works of art that have survived hundreds of years. I am sure there are many artists out there now that hope their contributions to the world will also last that long.

You’re probably wondering what painting has to do with photography and this review. There have been some tools released in the past that would allow you to turn your images into what could pass for a pseudo-painterly effect. Some could produce output that was better than others, while some would require further work to achieve results that would be usable.

With Topaz Impression, all this changes. The plug-in works the same way that the masters did, by laying down a single brush stroke at a time. According to Topaz, Impression does the same thing…but it can lay down a  lot more strokes in a lot less time: they estimate about 10,000 strokes per second.

<insert imp1.jpg here>
The above image is one I took at the Peninsula a couple years ago. A nice shot of the fall colors… but how would it look if painted by one of the Masters?

Firing up Topaz Impression, I had it channel Monet for the following image, using the Monet 2 preset:

<insert imp2.jpg here>
I know it’s hard to see much of any real detail in the printed newsletter… the full color PDF version shows you the results in more detail. But the results are definitely in the Monet style. The original photo is nice by itself, but the look of the processed image gives one a calm, serene feeling (at least to me), that could produce  the desire to just look at it for a long time.

The original image is a true rendition of the scene as shot and as my eyes saw it. The processed one allows the photographer to have his work viewed in a different way, which may make it an even better image in the end.

As with the other plug-Ins, Impression allows you to alter the presets, to give you the freedom to make the effects match your style and taste…. rather than keeping the canned look. With this ability, who knows what you can potentially come up with… an improvement on the Old Masters? Something to think about….

Under the Stroke section of the preset editor, you can change the brush style and size, as well as a number of settings relating to the paint volume, color shift of the brush strokes, even if there should be some smudging in the stroke. You also can control the color properties of both individual colors as well as the overall color range, adjust brightness and contrast, and even change where the light source is located in the rendered image. A final set of options allows you to select the type of material for the substrate (media), such as canvas or brick, and adjust several parameters for that surface texture.

The presets are just a starting point. Explore the option settings in each, and see what you can create as a new preset. The choices are endless.

InFocus
No matter how sophisticated the technology gets, one of the big curses of photographers everywhere is taking a photo only to find out later it’s blurry or out of focus to some extent.

With film, there wasn’t much you could do to remedy the situation. With digital images, however, there's various options to be had. One of the newer ones is Topaz InFocus.

Some of the sharpening tools available work by increasing edge contrast, or the difference in brightness between areas of your photo, to make it appear sharper. A lot of this sharpening happens towards the end of the post-processing workflow, but there are times when you can do some input sharpening or sharpening mid-stream. All help to increase the quality of the image, but at the expense of adding in artifacts that need removal at another stage.

InFocus operates somewhat differently. The software engineers at Topaz have developed complex algorithms that analyze your photos, and help to actually increase the sharpness of even moderately bad blurry images. There are some great examples on their website; see them at

http://www.topazlabs.com/infocus. The plug-in can handle not only out-of-focus shots, but also those that are victims of motion blur, with less chances of introducing unwanted artifacts. 

InFocus is the simplest of the plug-ins reviewed so far in terms of controls to operate it. The following image is a capture of the plug-in as seen when first launched. The interface is very simple: a large preview window on the left, and a tools palette to the right that holds a total of six sliders. 

<insert inf0.jpg here>
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This is the original image above. It’s not TOO badly blurred, but there is an overall softness to it, which is more noticeable at the upper right of the picture frame. 

Opening the image in Photoshop and then the InFocus filter, I tried all the options in the pull-down menu in the DeBlur section. Only the last one, Unknown/Evaluate gives you the option of doing an automatic image evaluation when you apply slider changes. I found it much easier to adjust the sliders manually, as I could tweak them more to taste by hand rather than using the automatic choices. 

The other tool section on the right under DeBlur is Sharpening, where you can adjust the amount of sharpening and micro-contrast, to tweak the image even more.

<insert inf2.jpg here>
The bottom image on the preceding page shows the results of processing the image via InFocus. There is an overall increase in the sharpness, most notable in the upper right of the frame, and increased contrast in the text on the envelope next to it.

There are no presets in this one. All the adjustments are done by hand, or via the valuate function. But even using that, it may require further adjusting to bring out the most in the photo.

One thing to keep in mind: I tried using InFocus to sharpen some of my scanned film images. It did a small amount of improvement on them, but barely enough to make a difference. I don’t think it would work well with anything scanned. I may be wrong, which means I will be doing some more testing in the days ahead. But for now, I would suggest you try it on your scanned images with the trial version, to see if you have different outcomes.

One further note, if you have an image that is already sharp, you can also process it in this app, to give it a boost. Sometimes using the controls in Lightroom, or the Unsharp Mask routine in Photoshop, doesn’t quite make it. But running through this module may be just what it needs.

Lens Effects
One thing that growing up using film for photography was finding out that it was possible to change the look and feel of your images, and apply many different creative effects, by using filters over your camera lenses. You could use a polarizer to remove glare from water and darken the skies, change the tonality of black and white photos by using different colored filters, and more.

With the advent of digital photography, a lot of the situations that would require a filter have been taken care of, either in-camera or in post-processing. A lot of the effects that once needed a filter to achieve are now available with the click of a button. There are still some effects that require a physical filter to achieve… or even a specialized lens in some cases.

Topaz has collected a wide range of these filter effects together into this plug-in, giving you a  wealth of creative tools in one place, allowing you the freedom to modify the look and feel of your images with ease. You can find many of these effects in different editing tools, such as Photoshop, Elements, Lightroom, and others. Some will contain a set of them, others will be found in other tools or plug-ins. Unless the effect you are looking for is way out-of-the-ordinary, Lens Effects should give you what you are looking for, all in one place!

What can you do with the effects in this module? Quite a lot. The list of just the separate techniques is as follows:

● Bokeh

● Diffusion

● Color Filters

● Tilt-shift lens effects

● Creative Blur

● Vignettes

● Polarization

● Graduated neutral density filter effects

● Old school techniques and

● Motion Blur.

Quite a list. Quite an array of physical filters you’d need to purchase and carry with you to use when making your photos. But now you won’t need to have them, or to have the expense of buying them. For the price of just a few of them, you can have the entire lot.

<insert lef1.jpg here>
For this image, I opened it in Lightroom, and gave it a couple minor tweaks: added some fill light to brighten the face of the flower, adjusted the black level for a bit more contrast, and added a touch of clarity. Once those were done, I opened it into Photoshop, and then into Lens Effects.

My main mission here was to eliminate the line 1/3 of the way up from the bottom, where the foliage meets the parking lot behind it. I also wanted to blur out the leaves and stems as much as possible without affecting the flower itself.

Like the other Topaz plug-Ins, you can do effect stacking, to achieve a custom effect. I started here by applying the Bokeh Center Focus effect, and using the Extra Creamy preset under that. 

The first time around the flower was partially blurred, so I reset the filter, and chose a center point using the button in the effect tools. I then re-applied the settings, this time with the flower in focus. Since only one application of the filter did not blur the background enough, I applied it three more times, using the stacking feature. To do this, you hit the Apply button at the lower right of the tool palette. This applies the selected effect to the file, but does not alter the image yet (that happens when you hit OK to finalize your work and go back to your image editor).

The next step was to get rid of the brighter portion of the image, the area where the foliage meets the brownish looking portion of the parking lot in the background. 

One of the built-in effects in Lens Effects simulates a Graduated Neutral Density filter. This type of filter starts at one end clear, and gradually darkens to a neutral gray at the other. There are differing strengths of the filter that you can get for your camera, allowing for a darker transition over the image (you can also choose the strength of the filter, measured in stops of light, in the filter selector).

The lower third of the image was in need of the filter effect. You can choose which area of the image needs the application applied (any of the four sides), as well as adjust the angle of the transition. 

<insert lef2.jpg here>
When I applied the graduated filter, it fell right in the area it needed to as far as where the effect was needed. In the original image, I felt like I was looking out at the scene through a window blind slat, due to the bright area between the foliage and parking lot. But now as you can see in the final image here, there is no more harsh separation between the lighter and darker areas. The intended appearance of the photo has been achieved: a nice portrait of the flower itself, surrounded by muted, nicely out-of-focus background surrounding it. (And if anyone is wondering, NO I have no idea what the name of the flower is. It was a group of sunflowers that my wife grew in the garden a couple years ago. There was no indication from the seeds they would look like this, the seeds looked like any other normal sunflower seed. But they all came up this nice, feathered petal flower).

There is a TON of effects you can produce with this plug-in. To list them all would take a lot of pages. And each one has a number of presets with it, giving you more choices to choose from to enhance your photos. This is another one that you should download the trial and play with, just to see what it can do. Like I said before, to buy all the filters and even lenses to compare with what you get here, would run you many times the price of this plug-in. If your budget is tight, this will give you a place to go if you need something you can’t afford right at the time.

PhotoFXlab
This is an interesting one…well, more so than the rest, as all the parts of the Collection are definitely interesting. It’s a plug-in, for the simple fact that it can be run from within your editing host program as a plug-in. But it can also be run as a standalone application, outside of Photoshop or Lightroom, or whichever editor you use.

It reminds me a lot of Lightroom, but without the image cataloging and organization functionality of the Library module, and none of the other modules as well, except for the Develop module.

So what exactly IS PhotoFXlab? It’s a place where you can bring your image into, and have instant access to practically ALL the effects offered by the other plug-ins that make up the Topaz Photography Collection. It’s like a complete set of everything from all the plug-ins in one place, so you don’t have to switch between them to apply the effects you want.

<insert pfxl0.png here>
The screenshot above shows the main interface for PhotoFXlab. On the top left are four tabs, labeled Effects, Plugins, InstaTone and History. Effects gives you a list of available effects you can apply from within this module; Plugins gives you a list of what plug-ins of the Collection you have installed. If you do NOT have a certain plug-in on your machine, it will not show up in the list, and the effects will not be able to be applied…  in fact, they won’t be in the Effects tab list at all.

History gives you a list of what you’ve done in the module, so you can go back and remove steps from what you’ve done, just as you can in Photoshop.

<insert pfxl1.jpg here>
The InstaTone tab is an addicting feature of this module. What lies there is a way to modify your images using another image. You can select a photo on your computer, or go to several online sources such as 500px.com. When you find a photo you like the colors of, you can use it as a source to apply the same colors and tones to YOUR image. This will allow you to change the mood and feel of your photo to mimic that of another.

The bottom photo on the previous page is the source image I selected for the PhotoFXlab screenshot. It’s right out of the camera, no adjustments made to it at all. I went into the InstaTone tab, and browsed the images that Topaz includes with the plug-in. The image below shows the selection screen for their library. I chose the third image in from the left on the bottom row, the pink flowers, to apply to my image:

<insert pfxl2.png here>
The effect is visible in the preview window on the left side, to give you an idea of what the final effect of the process will look like. To apply it to the photo, you click the right-most button under the preview, which applies the changes to a new layer of your image.

PhotoFXlab works a lot like Photoshop in that it applies the changes to your image in layers. This gives you great flexibility in your editing. You can make an edit to your photo, but only have it affect certain areas by using the layer mask to omit the changes from where yo don’t want. them to be seen.

You can create new layers for different effects. Each one has an attached mask for your use, if desired. There is also the ability to flatten all the currently visible layers, just as in Photoshop. Then you can build even more effects on top of that new base layer, preserving everything that was done before from changes to those effects.

The following image shows the results of my effect choice:

<insert pfxl3.png here>
Quite a difference from the original photo. The details of your original are preserved. All that InstaTone does is substitute an outside color palette (from the photo you choose to use) and replaces the original one from your source photo. 

The right hand tool palette has controls allowing you to change such parameters as exposure, contrast, highlights and shadows, and add sharpening. Below the sliders is the layers palette, which shows the layers in your work. You also have controls for opacity adjustment (how strong a layer interacts with the others), and blending modes. Blending modes determine how a layer interacts with other layers (the ones below it). The results the blending modes give you varies by the processing it does to the image. The best way to see what each does is to try them out, one at a time (there’s only about a dozen). You might find an unexpected effect from changing the blend mode of your layer.

If there’s a certain process or effect you want to apply to your image, but it’s not listed in the Effects tab on the left, the Plugins tab allows you to launch the module you need to work with, without having to save your work and exit the Lab. Click on it, and you can work inside the plug-in right from within PhotoFXlab. Depending on how you need to process your photos, this can be a tremendous time saver, especially if you have a number of images you need to enhance.

I did encounter a problem with this module. When I would try to access 500px.com or 1x.com’s libraries in InstaTone, neither would load. There was no indication that anything was loading for either library (no progress bar), and no images would show in the picker window, even after allowing it to sit for a while. This behavior appeared both in the plug-in a well as the stand-alone modes of operation.

I even created an account on 500px and logged in via the lab interface, but it made no difference. Once you had the 500px information (category list) displayed, switching to 1x.com made no change to the display. In fact, 1x.com did not load any of it’s information into the window at all, so I have no idea what to expect from it.

The above issue MAY be due to my machine being on Windows 10. However, I will investigate further and report the issue to Topaz. Results of the troubleshooting will be reported as soon as I have them.

Do not let the bugs noted above deter you from at least trying this program. It works as advertised for all other functions, and really makes enhancing your photos a breeze. You can do a lot of processing here, then finish up in Lightroom or Photoshop on things it can not do internally.

  Stay tuned…. Next month brings the look at the last four modules in the Collection. See you then!
